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Data Editing in MapInfo Pro v2019 
A short walk thru of some of the things that makes editing in MapInfo Pro so 

easy. 

Attribute Editing 
MapInfo Pro allows you to change, edit or update attribute information in 

multiple ways. 

Native and NativeX tables can always be edited in MapInfo Pro, unless you 

don’t have write access to them at a file level. 

MapInfo Pro can access multiple other formats. Not all of these can be 

directly edited in MapInfo Pro. In order to edit these, you might have to save 

a copy of them into a native MapInfo format.  

 

Using the Info window, you can easily edit attributes of a single or few 

records at a time. Use the Info tool to click on the record you want to edit to 

show it in the Info window. 
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Notice that the Map Mini Toolbar shown in the image on the previous page 

has been customized for data editing. You can modify your own Map Mini 

Toolbar as well to hold exactly the tools you prefer for a given job. You can 

even have multiple versions which makes it easy to switch between the 

different Map Mini Toolbars. 

You can find custom tools on the MapInfo Marketplace that allows you to 

show the attributes of the selected record in the Info window. In many cases 

this is a help as you don’t have to switch between the different tools. Check 

out the tools InfoSelHandler 3.0 x64 or WindowHelper 3.0 x64. 

 

From the MapInfo Marketplace you can download, install and load the tools 

with a single click. The Marketplace also lets you know when there is an 

update to a tool you have downloaded from here. 

You can view your Map window and a Browser window of your table at the 

same time. In the image below, the two windows have been arranged in two 

vertical tab groups. Using the shortcut Ctrl+Shift+F you can easily view the 

selected record in both windows.  
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You can edit the attributes via the browser window.  

If you need to update multiple records, you can use the Update Column dialog 

to update an entire table or just the selected records (using the Selection) in 

a few clicks. 

The Update Column command is accessible from the Table tab but you can 

also add it to the Map Mini Toolbar for quick access. And you can assign a 

keyboard shortcut to this and any other command in MapInfo Pro using the 

Command Editor tool from the Tool & Extensions window. 

With MapInfo Pro v2019, the Update Column command can also be found in 

the new SQL dropdown that you can find on the Table, Map and Spatial tab. 
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If you have the MapBasic window open when running an Update Column 

command, the statement will be recorded. You can now execute this 

statement again simple by positioning the cursor in the line and hitting Enter 

on the keyboard. Depending on your Preferences for the MapBasic window, 

you might have to hit Ctrl+Enter. 

If you use the MapBasic window, you can also modify the Update statement 

to update multiple columns with one statement simply by separating the 

individual column = value pair with a comma (,). 
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Any SQL statement that you execute in MapInfo Pro v2019 will be recorded, 

and you can find these in the Scripts dropdown in the SQL Window 

throughout the session. From here you can modify the script and run it again. 

The layer does not have to be editable in your map window for you to update 

the attributes via the Browser window, via the Info window or via Update 

Column. 

MapInfo Pro also comes with a tool, Search & Replace that lets you search for 

specific sub strings to be replaced with other sub strings. 

Making a Layer Editable 
MapInfo Pro allows you to quickly start editing any layer opened in a map 

window. 

You can use the Layer List in the Explorer window to make a specific layer 

editable, you can use the Editing dropdown list in the Statusbar and you can 

use the context menu of the map window to make the selection layer 

editable.
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This also means that you can quickly switch between different editable layers 

in case you are editing multiple feature types at the same time. 

You do not have to save changes to one layer before you can start editing 

another layer. You just switch between what layer you want to edit at any 

time. 

It is important to notice that you can only have a single layer editable at any 

time in each map window. You can however have multiple map windows with 

different editable layers and switch between these map windows. 

Vector Editing 
To edit the spatial elements of your data, you typically need to make the 

layer editable first. At least if you use the built-in tools in MapInfo Pro for 

doing the editing. 

Most vector editing commands are located on the Spatial tab. You can also 

find some on the default Map Mini Toolbar and as mentioned before you can 

add additional commands to the Map Mini Toolbar for easy access. 

You can make simple changes to your spatial data by selecting the element 

and then for instance dragging it to a new position. MapInfo Pro also has 

commands for offsetting objects more precisely if needed. 

For lines, polylines and polygons, you can also change the individual nodes of 

the spatial data or add new nodes, for polylines and polygons. 

First, you need to enable the Reshape state for the layer. You can do this via 

the Map Mini Toolbar or via the keyboard shortcut Ctrl+R. Reshape is also 

accessible via the Nodes dropdown on the Spatial tab. 
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Now you can see the individual nodes of the selected object and using the 

Select tool you can select these nodes and move them using the mouse or 

delete them using the Delete key on your keyboard. 

You can move the centroid of the object if you have set the layer to show 

these. You can easily set this via the Style tab when the layer is selected. This 

only works for polygons. 

The centroid is used to determining the position of the label unless you have 

asked MapInfo Pro to use the Auto Position option. 

 

You can also activate the Add Nodes tool and insert new nodes between 

existing tools. You can access the Add Nodes via the Map Mini Toolbar, via the 

Nodes dropdown on the Spatial tab and via the keyboard shortcut 

Ctrl+Shirt+N. 
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You can enable Snap using the S-key on your keyboard to snap an existing or 

new node to another node in the same layer or in a different selectable layer. 

MapInfo Pro has numerous tools for modifying spatial objects. Some of these 

are built-in to MapInfo Pro and some of these come with the MapCAD tool 

that comes with MapInfo Pro. You might have to load this tool manually from 

the Tools & Extensions window 

Once MapCAD has been loaded either manually or automatically, the user 

may not notice the difference between the built-in tools and those from 

MapCAD as MapCAD is integrating its tool smoothly into the interface of 

MapInfo Pro. 

In the image below, you can see some of the CAD or object editing tools 

available in MapInfo Pro. 
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You can use the Quick Search tool to find the tools you are looking for. Type a 

search string into the tool in the top right corner and see a list of matching 

tools. Once you click on the tool, it will get activated and it will also become 

highlighted in the interface. 
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Adding Spatial Data 
So far we have looked at editing existing data, spatial and attribute. MapInfo 

Pro also allows you to enter new data into an existing table. 

You will often start with entering the spatial data by adding this to the 

editable layer via the map using one of the many tools. And then update the 

attribute information afterwards, using the Info window or a browser 

window. 

You can access the tools via the Map tab where you can find the built-in tools 

in the Insert dropdown. 

 

Or you can use the Insert dropdown on the Spatial tab where it also contains 

the Insert/Create tools from MapCAD. 

 

The built-in tools and some of the MapCAD tools support snapping to existing 

nodes in the same layer or different selectable layers. 

The tools that allow multiple nodes have a number of other features that 

come in handy when drawing. 
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You can: 

• Activate Snap using the ‘s’ key on your keyboard 

• Activate Trace by holding down the Ctrl or Shift key on your 

keyboard after having started drawing your polyline or polygon. 

Trace lets you follow existing objects in the editable layer or other 

selectable layers in the map. Do note that trace only follows one 

object at a time. This requires Snap to be active. 

• You can also turn on Autotrace using the ‘t’ key on your keyboard. 

This enables MapInfo Pro to trace along the feature you have 

snapped to. This requires Snap to be active. 

• You can by holding down the Shift key draw line segments locked at 

45 degree angles, say, 45˚, 90 ˚, 135 ˚ etc. This requires Snap not to 

be active. 

• You can by holding down the Ctrl key draw line segments locked at 

45 degree angles related to the previous line segment, say, 45˚, 90 ˚, 

135 ˚ etc. This requires Snap not to be active. 

• Activate Autonode by hitting the ‘n’ key on your keyboard. MapInfo 

Pro will now automatically add nodes to your polyline or polygon as 

you move the cursor around the map. 

• Delete nodes when drawing polylines and polygons using the 

Backspace key on your keyboard 

• Show a crosshair across the entire map by hitting the ‘c’ key on your 

keyboard. 

• Change the size of your cursor using the ‘x’ key on the keyboard. 

• Zoom and pan in the map while drawing using the arrow keys and the 

plus (+) and minus (-) keys on your keyboard. 

• Scroll the map while drawing by moving the cursor outside the area 

of the map. 

• Pan the map by holding down the Scroll Wheel and moving your 

mouse. 

If you have the Info window open while adding new records, the new record 

will be shown in the Info window when you have finished drawing it. This 

makes it easy to add attribute information to it.  
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Also note that MapInfo Pro is using the current style for the new spatial 

records that you are adding. You can change these afterwards or before you 

draw the spatial objects.  

You can also set a style per layer and in this way control the style used for 

new records added. This is set via the Layer Properties dialog that you access 

via the context menu of the layer. Notice that the Styles for New Objects only 

is accessible when the layer is editable. 

This is saved to the metadata section of the table and so saved across 

sessions. 

If you have applied a theme on your layer, the style of the newly added 

features with adopt the styling from the theme as they get created or have 

their attribute data changed. 

Saving changes 
To save your changes, use the Save Table command. You can access this from 

the HOME and TABLE tab. By default this command is also available via the 

Quick Access Toolbar at the top of the MapInfo Pro application window. 

Finally, you can access it via Ctrl+S. 

If you have made a mistake when creating a new record or changing an 

existing record, you can use Ctrl+Z to undo this change. MapInfo Pro only 

allows you to undo the latest change. This change can have effected multiple 

records and in that case, all these changes will get undone. 

Your System Settings control how many records you can undo changes on. 

You can also specify this as an amount of memory. 
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If you have made some changes that you don’t want to save, you can always 

revert your changes to the last time you saved your table. Revert Table is 

accessible via the Table tab. 

Multi User Editing 
While you are editing a table in MapInfo Pro, the changes are stored in a set 

of transaction files. The transaction files prevents other users from editing 

the same set of tables that you current are editing. 

You can however if your data is stored in a spatial database, use personal 

tables and in this way have multiple users edit the same database table thru 

individual tables. 

If multiple users are editing a table at the same time, there is a chance that 

two users edit the same record. MapInfo Pro has a Conflict Detection and 

Resolution mechanism that lets the user know if another user has made 

changes to the records he is trying the save. It’s now up to the user to decide 

which version of the record to keep. 
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When you are saving changes to a spatial table, it’s recommended also to 

refresh the table to get changes from the database loaded into your local 

table. This is especially important if there are multiple users editing the same 

tables or if you have triggers updating the data as it get inserted or updated 

in the database. 

Coordinate Precision 
MapInfo Pro stores coordinates in the tab files using Integer values. This has 

an effect on the precision of the coordinate system that you need to be 

aware of. A typical unbounded coordinate system, for example Lat/long 

WGS84, has a resolution of just around 10 cm. For many use cases this is 

sufficient. 

For more local coordinate system, often projected coordinate systems, the 

bounds are more local around the targeted area. This has a positive effect on 

the resolution of the coordinate system where it can get lowered to a sub-

centimeter resolution. 

You need to be careful when working with data in different projection or 

with different bounds. This can make it impossible to snap object together as 

their resolution isn’t aligned. 

When trying to visualize the resolution of a coordinate system in MapInfo 

Pro, think of a squared piece of paper where the points can only be inserted 

where two lines cross each other. 

This means that you might not always be able to 

insert a new node directly on an existing line as the 

line might cross where there is no intersection point. 

This is what the image to the left illustrates. The two 

red lines begin and end in intersections of the black 

lines which illustrates the resolution of the coordinate system. 

But the intersection between the two red lines isn’t located at an intersection 

of the black lines. If you were to create a node at the red intersection, it will 

be moved to the nearest black intersection. 

MapInfo Pro lets you create points in the Cosmetic Layer in a map window. 

You need to know that the resolution of the cosmetic layer in any map only is 

around 10 cm no matter what coordinate system you are using in your map.  


